Processo novo de implantacdao das impressoras no servidor
PRINTWSUS

Todos os campus teraoc um servidor SiglaCampus-PRINTWSUS com IP:
10.x.1.61, nele serao instalados os softwares NddPrintHost, NddPrintRelease e
NddPrintAgent. Existe uma imagem do servidor PRINTWSUS pre-configurada
com os softwares e ferramentas necessérias para a utilizacdo futura dos CSTI.

Softwares necessarios para instalacdo estdo em:
\intranet.ifri.edu.br\NETLOGON\Up\Ndd Campus

Instalagao do Servidor
Acessar o Servidor AD Campus

Rodar o vSphere Client. Caso nao estejam instalados baixar de:
\\intranet.ifrj.edu.br\NETLOGON\Up . Fazer a instalacao!

e Abrir vSphere Client > Acessar 0 10.x.1.52. Nos campus gue s6 tem um
DELL, acessar 0 10.x.1.51 > File > Deploy OVF Template >
http://200.20.221.165/5erverPrintWsus.ova 2 Next

e Detalhes do template > Next.

e Name: SiglaCampus-PRINTWSUS 2> Next.

e Disk Format: Thin Provision >Next.

e Destination Networks: Clicar e selecionar VM Network > Next.

e Marcar > Power on after deployment = Finish.




=] Deploy OVF Template _ . g =1

Ready to Complete
Are these the options you want to use?

Source

OVE Template Details When you didk Finish, the deployment task will be started,
Name and Location Deployment settings:
Disk Format OVFfile: http://200.20.221.165/ServerPrintWs us.ova
Lietrork Mappin Download size: 8,3 GB
Heaby bo Complete Size ondisk: 18,9 GB
Mame: CDUQ-PRINTWIIS
Host/Clusber: srvcdugvmO2.intranet.ifj.edubr
Datastors: datastorel
Disk prowvisioning: Thin Prowvision
Metwork Mapping: WM DMZ"to "wM Metwork”

i Power on after deployment

Help = Back I Finish I Cancel

Acessar Servidor de PRINTWSUS

Abrir porta no Firewall do Windows, - Windows Firewall com Configuracdes
avancadas 2> New Rule 2 Custom -2 All Programs - Protocolo Type: TCP >
Local Port: Specific Ports > 5656, 56562 > Next > Next > All the connection
- Next > SIMPRESS - Finish.

Configurar IP: 10.x.1.61; Mask: 255.255.255.0; Gateway: 10.x.1.1; DNS&:
10.x.1.60 e 10.1.1.101

Ativar Licenca do WINDOWS 2008 R2.
Renomear VM: SiglaCampus-PRINTWSUS
Colocar no dominio: intranet.ifrj.edu.br
Verificar DNS.

Abrir Print Managment - Print Management > Add/Remove Server > Add
Servers Atual de impressao (AD) > Add to List > OK.



Add/Remowve Servers ﬂ E I

Configure Print Managemenk I

—Specify prink server

Add servers:

| Browwse. ., . I Add b Lisk I

Add Ehe Local Serwer I

— Prink servers

RT-PRIMTWSLS {local) Remove I
gidean
Remove All I

(o] 4 I Cancel I Apply I Help I

Exportar impressoras para arquivo: Print Servers - Botao Direito no
Server AD - Export printers to a file > Next > Next.

‘ﬁ;u Print Management =]
File  Action  ‘iew  Help

s sE=  HE

ﬁm Print Management Marne Actions
=1 F| Custom Filters 4 | Drivers e .
[ All Printers (23) ok Forms
Bl (% Al Drivers (16) 0 Ports More Actions >
[# [# Printers Mokt Ready . Prinkers
[ 7| Printers With Jobs
o B
s | Dri Add Printer...

Export prinkers ko a file...
1 Ports Import printers from a file. ..
[ Printers Set Motifications. ..
[+ = Deployed Printers Properties. ..
Wigw 3
Export List, ..
Help

|Expurts prinker queues and drivers ko a file, | |

Export printer data to: > Browser - Area de Trabalho > Definir nome:

impressorasDoCampus.pmf 2> Abrir > Next > Resumo dos itens a Exportar >
Exportando - Concluido.



ia Printer Migraktion

Exporkting...

Export complete

|

The operation completed with no errors,

Open Event Yiewer, ..

= Back Cancel

Importar impressoras para PRINTWSUS: Print Servers 2 SiglaCampus-
PRINTWSUS > Importar impressoras do arquivo > Browser > Area de Trabalho
- Selecionar arquivo IimpressorasDoCampus.pmf 2> Abrir > Resumo dos itens
a importar > Next > Atencao AQUI!

Modo de importacao: Overwrite existing printers.

Listar no Diretério: Don't list any printers.

-3 Printer Migration

Select import options

Import mode:

Creerwrite existing prinkers

If the printer information file contains & prinker that is already installed on the print
server, the printer will be restored from the backup. {The target server printer will be
overwritten by the prinker From the File, )

Lisk in the directory: Dan't list ary prinkers j

[ Corwvert LPR Ports ko Standard Port Monitors

< Back I Mext = I Cancel |

Next > Pode apresentar erro Referente a portas da impressora virtual 2>
Concluido.




ia Printer Migraktion

Imporkting...

Import compleke

|

windows encountered errors during the migration process. Click '"Open Event
! ~ Miewer' For more infFormation.

Cpen Event Yiewer. ..

Cancel

= Bacl

Excluir impressora da fila virtual importada: Print Servers > SiglaCampus-
PRINTWSUS - Clicar em Printers 2> Delete: SiglaCampus-iIMPRESSORA.

Configuracao dos Softwares NddPrintHost, NddPrintRelease
e NddPrintAgent

Configurar NddPrint Host:

Abrir NddPrint Host:
Guia Impressoras

Impressoras 2 Configuracdes > Configuracao Unicast > Configurar >
Adicionar 2 P Inicial: 10.x.2.240 {(ou menor) - IP Final: 10.x.2.254 - Mask:
255.255.255.0 > OK > Fechar - Guia Filtro - Filtrar fabricantes > Digitar
SAMSUNG > Adicionar > OK.

Na Guia impressoras - Procurar Agora = Depois clicar em cada impressora
listada > Marcar Buscar nome impressora > OK.



Guia Usuérios

integracao Dominios = Adicionar > Nome dominio: intranet.ifrj.edu.br >
Servidor controlador: IP do AD Campus > Utilizar LDAP - Usuario (impressao-
svc) e senha > Validar usuario > OK > Selecionar o dominio intranet.ifrj.edu.br
> Fechar.

Configurar Autenticacdo > Marcar: Permitir autenticacdo por usuario e senha;
Permitir autenticacao por identificador fisico; Exigir somente identificador fisico
e Permitir o usuario cadastrar seu identificador fisico > OK.

Ferramentas

Configuracao - Conectar com nddPrint Server na Nuvem > Configurar 2
Utilizar nddPrint Data Center da NDD > Nome da Empresa: IFR] 6976 > Chave
de identificacao da empresa: 3D-B7-19-15-3D-AD-0C-85-6F-98-4C-6E-AE-D6-
8C-0E > Teste de conexao - Sucesso > OK > OK > OK.



Configurar NddPrint Releaser:

Abrir NddPrint Releaser:
Guia Ferramentas - Configuracdes

Aba nddPrint Host > Endereco do NddPrint Host: 10.x.1.61 - Testar conexao >
Sucesso 2> OK.

Informacio | x|

Aba Documentos pendentes > 12 > Aplicar.

Aba ldentificagao > Dominio integrado: intranet.ifrj.edu.br > Marcar Utilizar
Dominio selecionado para todos os documentos impressos - OK.

instalar as impressoras da fila fisica para autenticacao.

Em liberacao segura clicar em impressora - Adicionar - Avancar.

E}Assistente de adicido de impressora I

Assistente de adicdo de impressora

Ezte azsistente o guiard no processa de validacio e adicdo de uma
impreszora fisica. Chique em “awvangar'’ para iniciar.

ndd »Print

¢ albar I Seangar I Cancelar




Sao as mesmas informacdes da impressora no gerenciamento de impressao:
Avancar.

Dnssistente de adggodempressors |
Enderego do dizpositivo .
ndd »Print

Mesta etapa wocé deverd informar o enderego IP da impreszora fizica.

Enderego IF:
[10.4.2.241|
Mome da Fila:

IEF'AFE-S LREUMAD-IO

Localizagio:

Dezcrigio:

IE:-:.: Imprezzora do laboratdrio, monocromatica,

v Configurar propriedades SHMP. Meceszario cazo a impreszora ndo encontre-ze
cadastrada no nddPrink Host.

Observagao: Certifigue-ze gue o equipamento encontra-se igado e conectado na rede
caretamente.

{Wolkar Syangar » Cancelar

Versao %: public > Avancar
B assistente de adiciodeimpressora ——_________________H|

Propriedade SHMF do dispositivo .
ndd Print

Mesta etapa vocéd deverd informar oz dados de SMMNP da impressora fisica,

% Versdo 142

Comunidade de leitura:

|public]
0 VersiEo X
Llzuarnio: Contexto:
| |
Senha: Caonfirmar senba:
| |
Criptografia: Algaritimo de Autenticagdo:

I<53Ieciu:une ura opgans LI I<Se|eciu:une urna opgao LI

Observagio: Certifique-ze que o equipamento encontra-se igado & conectado na rede
caretamente.

{Wolkar Awangar > Cancelar




Avancar.

E}Assistente de adicdo de impressora E3 I

Informacdes do dispositivo ndd }Print

Mesta etapa tém-ze 0z dados coletadoz a partir do enderego formecido.

F abricante:

ISamaung

M odelo:

|M4080F:

Muirmero de sérnie:
|88 B OBHA000GEX
Maome da Fila:
|EF'.-'3«H-S LREUMAD-01
Endereco IP:
|10.4.2.241

Endereco fisico:
|30-CD-A7-CB-62-38
™ Cor

W Duplex

<Wolkar Awangar » Cancelar

Utilizar impressora para liberacdo de documentos e informar fila de saida.
Mesmo nome da impressora configurada > Avancar.

Dassistente de adigiodempressors K|
Objetivo da impressora fisica .
ndd »Print

Determine a forma que a impressora fizsica é utlizada para liberagio de
documentos, baseados nas configuractes do seu ambiente.

= Utilizar impreszora somente para liberagio de documentos retidos daz estages dos usudrios.

Ao escolher esta oppdo, oz dados da impreszora fizica gerdo utlizados para contabilizag3o,
aszim como calculos de custos e atrelag@es com terminaiz de liberagdo. Mao exige & criagio de
uma fila de saida neste zervidor,

= tilizar impressara para liberagdo de documentas retidoz no servidor de impressdo edou nas
estacies dos UsUAnNos.

M arcando esta opgdo a imprezsora fizica & automaticamente utiizada pelaz duas modalidades
de liberagin segura. Porém & obrigatono a definigdo da fila de zaida a ser utiizada neste
zervidor,

Fila de zaida:
CPAR-SLREUMAD-IO j Adicionar fila de zaida

Solkar Axancar Cancelar




Nome da impressora e fila de saida idénticos. Avancar.
B nssistente de adiio deimpressora K|

Resumo das informacoes .
ndd »Print

Mesta etapa, & poszivel confirmar az informactes, antes de zalva-las.

Cazo algumaz daz informagdes abaixo ndo estejam de acordo, cligue em "“Yolkar'.

Fabricante: Samsung

b odelo: M4080F]

Mome: CR&R-SLRELMAD-0M

Endereco IF: 10.4.2.241

Endereco MAC: 30-CD-A7-CB-G62-3B

Mimero de zérie: 028WELBH4000GE

Impreszora monocromatica cam modulo duplex habilitado
Descrigdo: Ex.: Imprezzora do laboratdrio, monocromatica.

Objetivo da impresscora fizica: Liberago no zervidor de imprezsdo edou em estagdes de usuanos.

Fila de zaida: CPAR-SLREUMAD-O

S olkar Asancar x Cancelar

Avancar.

[}Assistente de adicdo de impressora |

ndd »Print

Salvando informacbes.

Por favor, aguarde até que o processo seja concluido.

1 Toatal 0 Ermo
auCEsse 1 Suceszo 0 Avizo
Detalhes:
| Ao | Shatuz | Mensagem
{:}l Sdicionandao impressara no banco de dados | Sucesso |

el oltar Anancar Earmzelar




Concluir.

E}Assistente de adicdo de impressora

Assistente de adicdo de impressora
concluido

Fara finalizagdo, por favaor, clique em "Cancluir'’.

ndd »Print

cyalbar I Conciuir I Caricelar

Criar fila de IMPRESSAO VIRTUAL.
Em liberacao segura clicar em Grupos de impressao - Adicionar > Avancar.

[}nssistente de criacdo de grupo de impressao E3 |

Bem vindo ao assistente de criacio de
grupos de impressao

Eszte azzistente ird guid-lo durante o proceszo de criagdo de um grupo
de imprezzdo e manipulacdo de filaz de impressdo. Para inicid-lo, por
fawor, clique em “Awvangar »'

ndd »Print

< olbar Buancar > Cancelar




Nome do grupo de impressao: SiglaCampus-IMPRESSORA ou SiglaCampus-
SERVERPRINT (servidores novos) > Descricao: impressora Virtual 2> Avancar.

ansistente de criacao de grupo de impressao Ei |

ndd 3Print

HNome do grupo de impreszao

Por favor, digite 0 nome do grupo de impreszdo e cliqgue em “Avangar »".

Mome do grupo de impreszao:
IEBEL-IMPHESSDHA

[Descrigdo do grupo de impress3o:

IImpresmra YWirtual

™ Ciiar fila de IMpressao genenca

<Malkar Avangar » Cancelar

Driver: Samsung Universal Print 3

E}nssistente de criacdo de grupo de impressao E3 |

ndd »Print

Fila compartilhada de entada

Mesta etapa deverdo ser informados o dados para a criagdo da fila de
impressaon que receberd oz trabalhos de impressao.

MNome da Fila:
|I:DLII3-SEHVEHF'HINT |

Mome de compartilhamentao:
[CDUQ-SERVERPRINT |

Driver:

ISamsung Univerzal Print Driver 3 ll Adicionar... |

Observacdo: & porta desta fila de impress3o & uma porta criada pela MO Digital. E através desta
porta que og arquivos ficam retidos no servidor.

<Wolkar I Lovancar » Cancelar

Avancar.



E}nssistente de criacdo de grupo de impressdo E3 |

ndd »Print

Resumo das informagoes

Mesta etapa, & pozzivel confirmar az informacties, antes de salvélas.

Caszo alguma das informagdes abaiso ndo estejam de acordo, clique em ""oltar,

Grupo de impressao; COUGQ-SERYERPRIMT
Descrigdo do grupo: Imprezsora YWirkual

Fila de entrada: COUQ-SERYERFPRIMT
Mome de compartilhamento: COUG-SERVYERPRIMT
Comentarios: Impressora Yirtual

<Noltar Lwangar » Cancelar

Aguardar! Marcar Adicionar impressoras ac grupo de impressao. Avancar.

E}Assistente de criacao de grupo de impressdo | x| |

ndd Print

Criando grupo e zalvando as informagoes

Por favor, aguarde enguanto o asziztente zalva agz informagdes no banco
de dados.

Proceszo concluido sem erros, par favor, cliqgue em Avancar ='

¥ Adicionar IMprezzoraz ao grupo de impreszan ciado.

Deancar » | Canzelar

Selecionar as impressoras criadas, avancar e concluir.



i Impressoras !E[ E

Selecione az impressoras gue fardo parte do grupo de impressdo selecionado.
kodelo I Endereco IP I Mimero de zénie I Duplex I Colorida
{Samzung M4080F- 1042241 030wBOEBHA40...  Sim Mao
Samsung M4020F- 1042242 033wBLOEBH40...  Sim F&o
Samsung #43000x 1042244 O7FM=ET1BG300...  Sim Sim

[T Listar somente impressoras sem grupo de impress3o Anancar > I Cancelar

impressoras e grupo de impressao criados.

Configurar Fila de Impressao:
ir Gerenciador de impressao - Propriedades da Impressora virtual criada.
Guia Compartilhamento: Marcar Compartilhar impressora e lista no diretério

Guia Seguranca: Add > Gs_suporte Campus e Gs_suporte RT > Permitir Print,
Manage printers e Manage documents.

Add > SiglaDoCampus-GG 2> Permitir Print.
Guia Device Options : Print Model 2 Samsung X4300 Series

Finisher Opitions: inner Finisher

Ajuste de impressao Padrao
Guia Basic > Long Edge
Guia Paper 2 A4 e mm.

Guia Graphics > Marcar P%B quando disponivel.



Instalar os Softwares embarcados nas impressoras:

Acessar a impressora pelo navegador com usuario “admin”:
Primeiro instalar o ClientCollectorXoa 5.3.0

Guia Manutencao > Gestao de Aplicacao > Aplicacao > Adicionar - Procurar
- ClientCollectorXoa_5.3.0 > OK > Ok.

Home do pacote :  nddPrint Client Collector Samsung - 5.2.0
Fornecedor :  NDDigital
Nome | Versao EULA
nddPrint Client Collector Samsung 5.2.0 MN3o disponivel

0K || Cancelar

Atualizar a pagina do navegador.

Surgird uma nova guia XOA - Clicar em nddPrint Client Collector:
Escolha o tipo de servidor: nddPrint Host

Endereco do servidor: 10.x.1.61

Tempo de coleta: 1

Dominio Padrado: intranet.ifrj.edu.br

Habilitar Log: Marcar

SNMP Community: public

SALVAR!

instalar o ClientSamsungXoa

Guia Manutencao > Gestao de Aplicacao > Aplicacao > Adicionar - Procurar
- nddPrintClientSamsung-Xoa_5.10.2 > OK > Ok.



Nome do pacote : nddPrint Client Samsung - 5.5.1
Fornecedor : HNDDigital
Home Versao | EULA
nddPrint Client Samsung T Mo disponivel

oK Cancelar

Atualizar a pagina do navegador - Guia Seguranca - Controle de acesso do
utilizador:

Modo de autenticacao: Autent. Via Dispos.

Método de autenticacdo - item 7 nddPrint Client © Selecionar - Opcoes.
Protocolo de conexao: DCS

Endereco do servidor nddPrint Host: 10.x.1.61

Porta do servidor nddPrint Host: 5656

Habilitar Releaser: Marcar

Endereco do servidor nddPrint Releaser: 10.x.1.61

Porta do servidor nddPrint Releaser: 5656

Login Administrativo: admin

Senha: Mesma senha que acessou a impressora

Confirmacao de senha: Mesma senha gue acessou a impressora
Tempo de expiracao de conexao: 60

SALVAR e APLICAR!

Depois de instalar os dois plug-ins na impressora reiniciar.

Guia Seguranca - Seguranca do Sistema - Reiniciar Dispositivo 2 Reiniciar
Agora.



Testar autenticacao:

Abrir o nddPrint Releaser - Liberacao Segura 2 Documentos retidos:
Filtros do trabalho: Todos

Dominio\Usuério: intranet.ifrj.edu.br

Grupos de impressao: SiglaDoCampus-IMPRESSORA > Pesquisar
Solicitar o usuario enviar impressao e ver se aparece na fila.

Pedir para retirar a impressao e confirmar a saida da fila.

Impressao por autenticacao finalizada!

Configurar politica de grupo para a impressora Virtual.

Instalar Group Policy Management-> Server Manager > Features > Add
Features > Group poliy Managment > Next - install

GPO > User Configuration - Policies >Windows Settings - Deployed Printers
> Deploy Printer 2> \\Sigla_Campus-PRINTWSUS\Sigla_Campus-SERVERPRINT

User Configuration - Prefences > Control Panel Settings 2 Printers >
New - Shared Printer > Action: Update; Share printer: \\Sigla_Campus-
PRINTWSUS \Sigla_Campus-SERVERPRINT > Marcar Set this printer Default>
OK.

User Configuration 2 Prefences > Control Panel Settings 2 Printers 2>
New = Shared Printer 2 Action: Delete; Share printer: WAD-
Campus\IMPRESSORA > OK.

Botao direito na tarefa de deleta impressora e mover para cima.

Permissao para CSTI do Campus acessar e gerenciar
servicos no Servidor

Abrir CMD - digitar: lusrmgr.msc > Groups = Adminitrators > Add >
incluir Gs_suporte_Campus > Check Names > OK > OK - Fechar janela.

Reiniciar Servidor!



